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OneCNC Wire EDM is a hybrid CAD-CAM system with a user-friendly 
interface for designing and wire-cutting parts using 2 or 4 axis CNC 
machines.

OneCNC integrates the Microsoft Windows interface with a powerful 
CAD engine.  Parts can be designed and modeled in OneCNC, or 
imported from 2D or 3D CAD files.  The part model and geometry 
data is directly available to the inbuilt CAM functions.

The purpose of this Manual
This manual covers OneCNC WireEDM Expert, Professional and 
Express.  The manual provides information on how to get started and 
use OneCNC, it is not designed as a machining instruction manual.

Much of the information in this manual is also contained in the 
OneCNC Help file, which also contains tutorials and reference 
information about available procedures and commands.

OneCNC WireEDM
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OneCNC Environment

OneCNC has been designed as an integrated manufacturing 
environment, with purpose built interaction between the CAD and 
CAM functions.

New users familiar with Windows-based software will be at home 
with the well organized pull-down menus, toolbox and shortcut keys 
together with meaningful graphics included throughout the software 
interface.

The interface is similar to other common Windows-based drawing 
software and provides compact access to frequently used functions.  
Users experienced with other mechanical CAD software will appreciate 
the ability to customize the functionality in a way they are used to 
using.

CAD functions
The CAD functions are used to draw and create parts.
Line, arc, and spline geometry can be combined with NURBS surfaces 
and solids in a hybrid modeling process.  As well as the complete CAD 
functions for constructing parts from scratch, robust translators are 
provided for importing parts in other formats.  2D drawing and 3D 
modeling methods have been designed for ease of use.

CAM functions
The CAM functions are used to create the required NC program 
toolpaths for CNC machining of your parts.  Toolpaths can be edited 
and reviewed in the NC Manager, which also has functions for 
backplot, real time preview, and metal removal simulation.

Multiple Views
OneCNC can show single or multiple views of the same object or 
model.  Any view can be dynamically panned, rotated or zoomed.  
Multiple views make it easier for you to create complex models.  While 
in a command it is possible to select a point in one view and then 
select the next point from another view.

Multiple Document
You can have more than one part drawing open in OneCNC. This 
makes it easy to cut and paste from one drawing to another and 
toggle between drawings.  The Recent File tab shows previews of 
files to help you quickly find the drawing you want.  Document 
management is simple in OneCNC due to the fact that the CAM data is 
stored in the drawing file.
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OneCNC Installation

Minimum System Requirements

Operating System
Microsoft Windows 10, 8, 7, Vista or Windows XP (32 or 64bit)
Internet Explorer 7 or later
NTFS File System is recommended

Hardware 
Minimum 1 GB of quality memory for Windows XP, or 3 GB of quality 
memory for Windows 8, 7, or Vista, especially if working with complex 
parts.

Pentium 4 single, dual, or quad core PC.  AMD Athlon can be used 
only if later than 2004 with specs equal to the Pentium 4.

NVIDIA GeForce or similar OpenGL and DirectX graphics card, 
minimum 1Gb.  It is essential you download and install the latest 
graphics driver for your card, as drivers supplied on install discs may 
be outdated due to production lead times.

A mouse with 3 or more buttons and a scroll wheel.
One available USB 1.1 or 2.0 port or a suitable parallel port depending 
on which licensing dongle you have.
CD-ROM drive for installation of standalone version if required.
Broadband Internet access is recommended for updating the 
software.

OneCNC Installation

You will need:
OneCNC installer disk or a downloaded update setup file
OneCNC dongle
CD Key and serial number

There are three steps to installing OneCNC on a single computer:
Install the software from disk or an update setup file
Plug in the dongle
Run OneCNC and enter the serial number to activate it

For network installations, network server software must be installed 
as well.  That process is outlined in the next chapter.
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All OneCNC products can be installed from the one installer package.

Insert the OneCNC CD or plug in the OneCNC flash drive. 
Display the drive contents in Windows Explorer and double click 
‘onecnc_setup.exe’

Language Selection
Select your language from the drop down list.

Units Selection
Select the units you work in, Metric or Imperial (inches).  This will set 
the default drawing units and post-processor configuration units.  The 
units setting can be changed after installation using the Properties 
dialog on the File menu.
One CNC will open a file drawn in the alternate units at the correct 
real world size, but the NC toolpaths will be invalid, so you should 
save the files to separate locations.

CD Key
OneCNC installation requires a CD Key, which is usually found on 
the inside rear cover of this manual with your serial number, but is 
sometimes shipped separately from the software for security.
Enter the CD Key and click the large ‘play’ button to start the 
installation.  

The serial number will be requested when you first run the software.    
Keep a copy of your CD Key and Serial in a safe place as you will 
need them if you upgrade your computer and need to re-install.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install OneCNC.  You can accept 
the default location or click the Browse button if you want to select 
your own location.  Click Next when you are ready to continue.

In the confirmation dialog you can click Back to review your settings, 
or click Next to install OneCNC.

If you are upgrading from a previous version of OneCNC, the new 
installation will be in a new location.

You can still use your existing tool and material libraries, and 
custom Posts.  To do this, copy the Settings folder from your 
previous installation to your new installation Settings location.

It is good practice to keep a backup copy of your Settings folder.
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OneCNC Updates

Registered users can download updates of the setup file for their 
version of OneCNC at no extra charge.

Go to http://onecncsupport.com/ and click on OneCNC Updates 
when you have read the update details.
Click on Check For Updates.

Enter your dongle and serial numbers to enter the site.  Click on the 
Register button on the next page to appear.  Fill in your registration 
details, and click Save.  Click on the Download button to go to the 
actual download page.

Select the check box to confirm you have read the update details, 
and click on the Download button.  A dialog will appear asking if you 
want to Run or Save the file.  Select Save and choose the folder on 
your computer to save the file in.  Double click the downloaded file 
to install the update.

The update can also be accessed by clicking on OneCNC Updates in 
the Help menu, or the OneCNC Software Updates, Drivers and Posts 
link in the OneCNC Users Forum.

When all the files have been installed, click Finished to complete the 
installation.  There will be a pause while the dongle driver for Series 1 
dongles is installed.

When the installer closes, you are ready to insert the dongle and start 
OneCNC.
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Dongle Installation

OneCNC requires a dongle for the licensed program to run.
A dongle is a small hardware device which verifies your software 
license.

Series 2 Dongle Installation - dongle numbers from 10000

All OneCNC dongles with a number higher than 10000 are Series 2 
dongles.  

Series 2 dongles are USB HID devices which look like this.  These 
dongles do not require drivers for a single computer installation.

If you have a network license you will need to install a network dongle 
driver, as described in the next chapter.

To install a Series 2 dongle
Make sure OneCNC is not loaded or attempting to load.  To install the 
dongle simply plug it into a USB port on your computer.  Basically, if 
the dongle fits, it’s the correct port. Do not try to force the hardware 
or you may damage your computer or dongle.

If you have a timed licence the Windows date and time must be 
correct before connecting the dongle.  It is recommended that the 
USB port a dongle is plugged into should not be used for other 
devices.

Dongle Security

Because it is the dongle which verifies your purchase of OneCNC, 
if a dongle is accidentally damaged or broken the damaged dongle 
must be returned to OneCNC before a replacement dongle can be 
issued.

If a dongle is lost or stolen, the replacement price is the full price 
for the software.  Take steps to secure your dongle, and insure it for 
the replacement cost of the software.
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Series 1 Dongles - dongle numbers 1 to 9999

If you have upgraded from an earlier version of OneCNC, you may 
have a Series 1 dongle with a number less than 10000.

These dongles may be USB or Parallel port dongles, and are now 
obsolete.

There is no 64 bit driver available for these older dongles, so if 
you have a series 1 dongle please see your OneCNC dealer for a 
replacement series 2 dongle.

A series 1 dongle will be replaced at no extra cost with any upgrade to 
the current version of OneCNC.

Note: 
 
A series 1 dongle will not run the 64bit version of OneCNC.

Until you get your replacement dongle you can install the 32bit 
version of OneCNC on 64bit Windows by changing the last two digits 
of the CD Key to 32.  For example the CD Key 6432 will install 32bit 
Mill Express which can be run with a series 1 dongle.

When you change to a new series dongle re-install OneCNC with the 
standard CD Key.
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Network licence - Series 2 dongle

To run OneCNC on a client PC connected to a network using a Series 
2 dongle, you must select ‘Network licence’.

To run OneCNC on a computer which is also the network server, the 
server installation needs to be set to ‘Single user licence’, as in this 
case the dongle is on the local system and not on the network.

Start OneCNC and enter the Serial Key

Once installation is complete and the dongle is installed, OneCNC can 
be started.  Double click on the OneCNC shortcut on your desktop, or 
select the OneCNC shortcut in the OneCNC folder in the Start menu.

The first time OneCNC is started the Licence Manager will look for 
the dongle.  Select ‘Single user licence’ if you have a standalone 
installation, and click Continue.
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The Licence Manager will open so you can enter the licensed user 
name and serial number.

The serial is made up of digits 0 to 9 and letters from A to F.  The 
code must be entered exactly as it appears.

When the serial key has been entered the Licence Manager will 
indicate that the licence is acceptable, and the software can then be 
started.

Entering serials for optional modules

If you have a serial for an optional module, 
start OneCNC and click on Register Modules in 
the OneCNC Help menu.

Enter the serial in the dialog which opens, and 
the module will be activated.
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User profile selection

OneCNC starts with this screen, which gives you the option of 
selecting the user profile you want to use.  The user profile stores all 
your settings such as toolbar layout, interface color settings and your 
recent files list.

Clicking on the small arrow opens the user selection dialog, which 
allows you to select or create settings in the names of specific users 
for customizing.



Page 15Introduction to OneCNC WireEDM ©

Select the user profile you want to 
use from the list, and click OK.

You can create, delete, and 
rename user profiles using the 
buttons below the drop down list.

Click here to start OneCNC 
with the selected user 
profile.

If your user profile or other settings are not being saved, open 
Windows Explorer and right click on your Settings folder.  Select 
Properties, and clear the “Read-only” check box.  Click Apply and 
click OK to apply the change to all subfolders and files.
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This step is only necessary for network installations.

For network installations, network server software must be installed 
on the server or computer the dongle is plugged into.

Series 2 dongles use the OneCNC Dongle Server which is included in 
the OneCNC installer, and is accessed by a CD Key similar to installing 
the OneCNC software itself.  

To install OneCNC Dongle Server on a computer or server with a 
Series 2 dongle, you will need: 

•	 OneCNC installer disk or a downloaded update setup file
•	 OneCNC dongle
•	 Network CD Key and serial number

OneCNC Network Installation
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Run the installer on the server computer.  To install the network 
dongle server software enter the CD Key 60200.

When the next dialog appears, enter the server software serial.  The 
serial is made up of digits 0 to 9 and letters from A to F.
This is not the same as the software serials which are entered later 
when installing the particular versions of OneCNC such as Mill and 
Lathe.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install the server software, the 
default installation is as shown.
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The next dialog indicates you will need to unblock the firewall for this 
application only.  Click Finish to complete the installation.

Here is the Windows Firewall dialog where you have to click Unblock 
for the dongle server software to work.  This has no effect on network 
or internet security, it is only allowing any PC on the local network to 
access the OneCNC Dongle Server.
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The server software is now installed and working.

There will now be an icon in the Taskbar at the bottom of your screen, 
indicating the dongle server software is running.

You can click the icon to open the Dongle Server interface, but it is 
not necessary to have the Dongle Server interface open for client 
computers to access the dongle.

The interface allows you to see how many clients are connected to the 
Dongle Server.  You will not see a connection as shown here, until the 
OneCNC programs are installed on the client computers.

To install OneCNC on the client computers, start the OneCNC installer 
on each computer, and load the OneCNC application using the CD key 
for OneCNC.
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Running OneCNC Dongle Server automatically

You can run OneCNC Dongle Server automatically so you do not have 
to start it if the server has been shut down.
Setting up a scheduled task will install OneCNC Dongle Server as a 
service which will automatically restart when the network server is 
started.

Firstly, install OneCNC Dongle Server as shown in the previous 
section.  You can then use the Windows task scheduler to set up 
an action to start the OneCNC Dongle Server when the computer is 
started.  You must be logged on as an administrator to perform these 
steps.

To open the Windows Task Scheduler, open Control Panel, click on 
System and Security, and click on Administrative Tools (if Control 
Panel opens in Classic view you can just double click on Administrative 
Tools). Double click on Task Scheduler.

In Windows Server, open the Server Manager and navigate to Server 
Manager > Configuration > Task Scheduler .

Click Create Basic Task.  Enter the name and description for the task, 
and then click Next.  Select When the computer starts, and click Next.  
Select Start a program, and click Next.  Click Browse to find the 
OneCNC server program, which will typically be at C:\OneCNC Server\
onecnc_server.exe  Click Next when you have selected the program. 
Review the settings you have made and click Finish.

Restart the server to apply the changes you have made.
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The OneCNC user interface has been carefully designed for ease of 
use.

Windows menus give you access to many features in OneCNC.  Menu 
items with a pointer on the right side automatically open sub-menus 
which you can slide the mouse across to select from.

OneCNC User Interface 

The Mill Expert interface is shown in this chapter.  The available 
modeling and CAM functions you see will vary for different types or 
levels of OneCNC.  OneCNC Solid Creator is intended for design only 
and has no CAM functions.
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Drawing Window 

The file you are working on is displayed in the drawing window, which 
is a real-time OpenGL model view.   This allows you to view your 
object by means of dynamic rotation, panning and zooming. 

Multiple Views of the same file can be shown.  When parts become 
complex it can be useful to view and edit one object from various 
angles simultaneously.  This function can be accessed from Window > 
Window Layout.
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Multi Document

You can have more than one file open in OneCNC.  When the file 
windows are maximized you will only see one file at a time.  You can 
select the file to display from the Window menu.

Clicking the Restore Window button will display each file in 
its own window.

The file windows can be controlled by dragging, or using the Cascade 
and Tile commands on the Window menu.
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Toolbox

The Toolbox is a menu system which is shown in the left sidebar.

When you start OneCNC you will see the toolbox 
Home menu.

The Home menu icons are grouped into 
commands for drawing, modeling, and CAM 
functions.

The toolpath functions available will vary with the 
version and level of OneCNC you are using.

Each icon in the toolbox Home menu will open a 
sub-menu from which you can select a specific 
command.

For many commands entry boxes will appear 
where you can input required values.

Click on the Home icon at the top of the Toolbox 
to return to the Home menu.

Clicking on the dotted button at the left of the toolbox will hide it.

Click on the button again to bring the toolbox back into view.
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Right Sidebar

On the right of the screen the right 
sidebar has panels for:

•	 NC manager
•	 Layers Manager
•	 CAD Verify
•	 History
•	 Recent file list

Clicking on the dotted button at the right of the sidebar will hide it.

Click on the button again to bring the sidebar back into view.

NC Manager

The NC Manager displays the 
toolpaths you have defined.

Machining operations can be grouped, 
and operations can be renamed, 
edited, rearranged or duplicated.
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Layer Manager

When you draw an entity it’s created 
on the currently selected layer.  The 
Layer Manager  is used to create, 
name or delete drawing layers.

The panel shows a list of layers in a 
drawing.  You can turn off a layer by 
closing the eye for that layer in the 
Layer Manager.  Entities on the layer 
are still in the drawing but will not be 
visible.

Verify

The Verify panel holds tools to read 
data from geometry.  

You can find exact values for position 
length or area for 2D entities, and 
volume of 3D solids.  You can also 
find the angle and distance between 
entities.

History

As you construct your part, a record 
of commands used is created in the 
History tab.
You can roll construction back or 
forward like a multiple undo and 
redo.  If you roll-back your history 
and start new construction, the rolled 
back construction is replaced with the 
new construction.

Recent Files list

When you save a file, a thumbnail 
image of it is added to the Recent file 
list.
The list shows if a file is open, active 
or closed.
You can open a closed file by clicking 
on the thumbnail image.
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Status Bar

The Status Bar at the bottom of the OneCNC window provides you 
with functions related to the appearance of objects, and a message 
panel which shows prompts to help you use the program.

Preset Views

OneCNC has a set of preset views so you can select the direction you 
want to look at your model from.

Click on the View icon to open the preset view selector.

Click on the icon for the view you would like to 
change to.

For 3D modeling the Isometric or Trimetric Views are 
the most commonly used.

The CAD View is a special view optimized for 2D 
drawing, so it is not suitable for 3D commands.  Use 
the Top View if you want to use 3D commands in a 
view similar to the CAD view.
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Construction Plane

When you draw or model in OneCNC you can use a coordinate system 
which is independent of the world XYZ coordinate system. 
OneCNC displays the Construction Plane which is a visual reference 
for the XY plane of the current construction coordinate system.

The Construction Plane is controlled using the Plane dialog, which 
is opened by the Plane icon in the Status Bar.

The Working With Planes tutorial in this manual covers the use of 
Construction Planes.

Display mode

Display controls the appearance of 3D surfaces and solids. 

Click on the Display icon to open the Display mode selector.

Click on the icon for the display mode you would like 
to change to.

If you are extracting 2D profiles from 3D objects it 
can be useful to use the Transparent or Wireframe 
modes to access obscured parts of the model. 

If you set the display mode to Wireframe, be sure 
to return it to another mode before attempting any 
modeling commands as you will not see any surfaces 
or solids.
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Section Tool

The Section tool is used to view a cross-section of your work 
parallel to the current working plane.  It can also be used to create 
section geometry.

3D to 2D Automated drawing system

In Expert versions of OneCNC and OneCNC Solid Creator you will 
see the Pages icon which opens the automated 3D model to 2D 
CAD drawing system.  This can be added as an optional module to 
OneCNC Professional versions.

Drawing Color and Style selection

OneCNC has a 2 color drawing system.  Color selection boxes 
in the Status Bar set the color for new entities.  The color 
selection box on the left is for geometry and that on the right 
is for surfaces and models.

To select the line style and line thickness for new geometry entities 
click the Styles icon.

Modifying Entities

Click Modify to change the color, line  thickness, line style or layer 
of existing entities.

Select the check boxes for 
the attributes you want to 
change and select the new 
values.
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Quick Access Toolbar

The Quick Access toolbar is a custom toolbar you can use to display 
icons for commands you use often.

When you install OneCNC the Quick Access toolbar will be empty 
except for the Quick Access icon.  Click on the Quick Access icon to 
open the Quick Access customization dialog.

Select the command you want to add in the Commands list on the left 
of the dialog.  A keyboard shortcut can be assigned to the command 
in the ‘Assign hot key’ entry box.

You can right click on an icon you use regularly to add it to the Quick 
Access toolbar.
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Keyboard Shortcuts

OneCNC provides a default set of keyboard shortcuts, which are a 
powerful way of accessing functions quickly by pressing a key or 
combination of keys.  You can add your own keyboard shortcuts in the 
‘Assign hot key’ entry box of the Quick Access dialog.

The following lists give the default shortcut key settings in OneCNC.

View shortcuts
Arrow Keys			   Rotate model horizontally and vertically
Arrow Keys + Shift		  90 Deg steps rotate right left up down
Ctrl + Arrow Keys		  Pan
Space Bar			   Preset View selection dialog
Space Bar double press	 CAD View
Delete			   Delete selected entities
F				    Zoom to fit
Z + Shift			   Zoom in
Z				    Zoom out
W				    Zoom to a window
Ctrl + 1			   Top View
Ctrl + 2			   Bottom View
Ctrl + 3			   Left View
Ctrl + 4			   Right View
Ctrl + 5			   Front View
Ctrl + 6			   Back View
Ctrl + 7			   Isometric View
Ctrl + 8			   Trimetric View
Ctrl + 9			   Dimetric View
Ctrl + 0			   Default View

Drawing shortcuts
P				    Point
L				    Line
R				    Rectangle
O				    Offset
H				    Hatch
C				    Circle with given radius
Ctrl + F			   Fillet Arc
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File shortcuts
Ctrl + N			   New file
Ctrl + O			   Open file
Ctrl + S			   Save file
Ctrl + Tab			   View next open file
Ctrl + P			   Print

Edit and modify shortcuts
S				    Select Single
L				    Select nearest line when in Single Select 
mode
A				    Select nearest arc when in Single Select 
mode
Ctrl + A			   Select All
Ctrl + Z			   Undo
Ctrl + Y			   Redo
Ctrl + X			   Cut to clipboard
Ctrl + C			   Copy to clipboard
Ctrl + V			   Paste from clipboard
Ctrl + D			   Delete
M				    Move
B				    Blank selection
T				    Trim One
Ctrl + T			   Trim Two

Mouse Actions

Left Button			   Enter / Select
Right Button			  Escape / End Function
Mouse Wheel		  Zoom to/from cursor
Middle Button + Ctrl		 Pan
Middle Button		  Rotate view
Middle Button + Shift	 Zoom
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The purpose of OneCNC is to create NC code programs for CNC 
machines.  The workflows for the various types of OneCNC are as 
follows:

OneCNC Mill or Mill with Multi-axis module
1.	 Draw or import part geometry or model
2.	 Define toolpaths to cut the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe
1.	 Draw or import part geometry or model
2.	 Define toolpaths to turn the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe with Mill-Turn module
1.	 Draw or import part geometry or model
2.	 Define turning and live tooling toolpaths
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC WireEDM
1.	 Draw or import part geometry or model
2.	 Define wirepaths to cut the part
3.	 Preview to verify wirepaths
4.	 Output NC program to send to the machine

OneCNC Profiler (Nesting for plasma, laser, waterjet or router)
1.	 Draw or import part geometry
2.	 Add part shapes to the Parts list
3.	 Nest parts to sheets
4.	 Define drill, engrave and cutting operations for the nested sheets
5.	 Preview to verify toolpaths
6.	 Output NC programs to send to the machine

OneCNC Overview 
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2D and 3D Geometry

Geometry drawing
OneCNC parts are constructed using pure geometry.  Boundaries can 
consist of lines, arcs or splines constructed in 3D space.

Layers
The Layer Manager sidebar panel is used to create, select, open and 
close layers which are used to organize your drawing.

Dimensions and Text
All 2D and 3D geometry can be dimensioned and annotated.  
Text labels can be added to parts and converted to geometry for 
engraving.

Drawing Layout Patterns
Borders, title and revision blocks, and bill of material lists can be 
saved as patterns and loaded into drawings as required.

3D to 2D Technical Drawing System
Expert versions of OneCNC include the 3D to 2D drawing system 
which automates the preparation of 2D drawings for printing.  2D 
technical drawings are created as page layouts in your ONECNC file, 
using title block and border templates.  2D views of the 3D part model 
can be created automatically and added to a technical drawing.
The system can be added to Professional versions of OneCNC as an 
optional module.
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3D Modeling

Available in OneCNC Expert and Professional versions

Surfaces Creation
Planar and curved surfaces can be constructed using the many 
available strategies.

Solids Creation
Solids creation from Primitives allows you to create basic shapes such 
as Cubes, Spheres, and Cylinders.  Solids can also be created by 
revolving or extruding geometry.

Hybrid Solids Creation
In the hybrid modeling technique a closed set of surfaces can be 
unioned to become a new solid.  Existing solids can be merged with a 
closed set of surfaces to become a new solid.

Model Operations
New solids can be created by the cutting, uniting or intersection of 
existing solids.  Solids can be split by a plane, or broken into separate 
surfaces.

Expert Tools
Expert versions of OneCNC have additional advanced modeling tools.
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Toolpathing

In all versions of OneCNC except Solid Creator, toolpaths can be 
defined by clicking an icon in a Toolpaths menu in the Toolbox and 
completing any selection or settings entries that the toolpath requires.  

Toolpath management

When you define a toolpath it will be 
added to the active toolpath group in 
the NC Manager.

An NC file can be output from a single 
operation, all the operations in a 
single group, or all operations in all 
groups in the NC Manager.

Right clicking on a group or toolpath 
will open a context menu with 
commands for frequently used 
functions such as preview and 
backplotting.

In Mill or Lathe the lower section of 
the NC Manager displays settings for 
the currently selected toolpath which 
can be edited.

Toolpath Backplot

Toolpaths can be backplotted, which means they are drawn as 
geometry on a special layer named Backplot.  Feed moves are drawn 
in green, and rapid moves in orange.  Reposition moves in highspeed 
machining are drawn in blue.
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Toolpath Preview

The Live Preview window shows an animated preview of the toolpath, 
backplotting as it goes.  In Mill or Lathe the cutting tool will be shown 
traveling along the toolpath.

Metal Removal Simulation (OneCNC Mill and OneCNC Lathe only)

In all levels of Mill and Lathe, OneCNC provides real-time toolpath 
metal removal simulation.  By simulating the feed and speed of the 
process, you can check the machining operation prior to sending to 
the CNC machine.

OneCNC Mill also provides Rest Material Verification, which highlights 
the thickness of material left on the part until it is fully machined.
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Outputting NC Files

Clicking the Process icon in the NC Manager opens the NC Processing 
dialog.  You can enter notes or a program number before the file 
is output.  OneCNC formats the NC file using a machine specific 
definition called a ‘Post’.  OneCNC is supplied with Posts for all popular 
machines, and it is easy to create a custom Post by copying and 
editing an existing format.

Editing  and sending the created program
When you output the NC file for your job it will open in OneCNC Link, 
the complete editor and DNC transfer program, where you can see 
your NC code before the final stage of sending the completed NC 
program to the CNC machine.
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OneCNC Integrated Help 

At OneCNC we put a lot of effort into making OneCNC the world’s 
easiest CAD/CAM package to use.  OneCNC has several features 
within the program to help new users quickly adapt to its powerful but 
easy to use features.

Help

If there is a specific part of the program you 
want to learn about, click on Contents in the 
Help menu.

The help files will open in a new window, 
with navigation controls at the top.
The Back or Forward buttons allow navigation 
between help files you have visited, like 
an internet browser.  The Home button will 
return you to the first page shown on the 
screen. 

Tutorials

Clicking on Tutorial in the Help menu will 
take you straight to the OneCNC Tutorials 
folder in the Help files.

There are step by step tutorials for 2D CAD, 
3D modeling, and how to define machining 
toolpaths for each version of OneCNC. 

Context Sensitive Help
OneCNC uses Context Sensitive help.  This means if you are using 
a function and need help on it, press F1 and OneCNC Help will open 
showing the relevant topic.
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OneCNC CAD Tutorial 1
Introduction To Cad Drawing

This Tutorial is designed for all OneCNC products.

This tutorial will quickly take you through the essential functions for 
drawing and modifying geometry in OneCNC, to get you up to speed 
in the shortest possible time.  In the exercises in this chapter, exact 
positioning is not important.  The aim is to get an overall view of the 
process of drawing in OneCNC.

Start a new drawing

When you start OneCNC you will have a new file ready to draw in.

You can also start a new file by clicking on the New File icon in the 
Standard toolbar.

The first thing you should do when starting work in a new file is 
to click Save and save the .ONECNC file.  If you save this tutorial 
you will be able to open it and resume where you left off if you are 
interrupted.

It is good practice to save your file regularly as you work.  When 
working on complex parts, you can use the Save As command on 
the File menu to make incremental copies of your work, saving as 
“file_01.ONECNC”, “file_02.ONECNC”, and so on.

It is strongly recommended that you save a backup of all your work 
in another location once a day, and in an offsite location every 
week.
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The part will open in the default 3D view.  The darker rectangle is the 
construction Plane, which indicates the XY plane of the coordinate 
system you will be drawing in.  Later you will see how you can move 
and rotate the Plane to define a new coordinate system but for now 
we will leave it in the default XY position.

Lines

We will start with lines, the most common drawing entity.

Click on the Line icon to open the Line menu in the toolbox.

The Line icon in the Line menu is highlighted, 
showing that the Line command is started 
automatically.

When the Line command is active, coordinate 
entry boxes will be available in the toolbox.  
Coordinate entry can be used for the first or 
second point of any line segment.

You can enter coordinates for a position in the 
World coordinate system, or the coordinate 
system of the current plane.

The current mouse pointer position is 
displayed in the toolbox, so you can also use it 
to check the position for a grid snap. 
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The mouse pointer will snap to grid positions in the drawing plane.
Click to select a start point for the new line.

The mouse pointer will have a preview of the line to be drawn 
attached to it.  Click on a new grid point to draw a horizontal line.

The Line command draws consecutive lines.  Click again to draw a 
vertical line from the last point.
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Move the mouse pointer horizontally again and you will see an 
indicator line when the new line endpoint is aligned with the start 
position.  Click to end the line on the vertical alignment.

Hold the mouse pointer near the start of the chain of lines and you 
will see the Endpoint indicator.  Click to end the new line on the first 
line endpoint.

Hold the mouse pointer near the previous line and you will see the 
Midpoint indicator.  Click to end the new line on the previous line 
midpoint.
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Right click to end the chain of lines.

The Line command will still be active.  You can start a line at a new 
position and continue as before.

Click near a line you have already drawn.  The start point will be on 
the existing line.

The toolbox will display the distance the new 
start point is along the existing line.

Change the value in the Distance along entry 
box to move the start point to a new position 
along the base line.

If you prefer you can enter the position on the 
base line as a ratio of the base line length.

The Distance along and Ratio along values are 
interactive.
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Move the mouse pointer near another line and click to connect to it.

Right click twice to end the Line command.

Click on the Select All icon to select the lines you have just drawn.

Click the delete icon to clear the drawing area.

Start the Line command again and practice drawing lines.
You can enter an exact position for a line endpoint by entering 
coordinates in the toolbox.  You can also define a line by entering a 
value for line length, or angle from the last line segment.

Delete the lines when you are ready to continue.
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Rectangle

The Rectangle command creates a rectangle with the option of a given 
radius fillet on all the corners.

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.

When the command is started, you have the 
option of entering a corner radius value.

Enter a Corner Radius of 5.

To define the first corner of the rectangle you can click on an entity or 
grid snap, or enter coordinates in the Toolbox.

This will be the point where the sides of the rectangle intersect before 
they are filleted.
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A preview of the rectangle is shown, with the second corner attached 
to the mouse pointer.  Click on or enter a position for the second 
corner.  The second corner can also be set by entering an X length 
and Y width for the rectangle. 

The mouse pointer is still active, ready to select a start corner for a 
new rectangle.

Draw some more rectangles, using different options such as a zero 
Corner Radius, or using values for Length or Width.

Right click when you are ready to end the command.

Click on the Select All icon to select the rectangles you have just 
drawn.

Click the Delete icon to clear the drawing area.
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Circles

The Circle command creates a Circle with a given diameter.

Click on the Arc icon to open the Arc menu in the toolbox.

The Circle icon in the Arc menu is highlighted, showing that the Circle 
command is started automatically.

Enter a Diameter for the circle in the Toolbox.  

A preview of the circle is attached to the mouse pointer.

Click on or enter a position for the center of the circle.
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The Circle command continues and you can place another circle by its 
center point.

You can change the Diameter in the Toolbox before placing the next 
circle.

Right click when you want to end the Circle command.

Click Select All and then click the Delete icon to clear the 
drawing area.
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Offset entities and boundaries

An offset entity or boundary is often needed when drawing a part.
In OneCNC this is done using the Parallel/Offset command.

To practice the Parallel/Offset command, draw a rectangle with filleted 
corners.

Offsetting single entities

Click on the Parallel/Offset icon in the Line menu to start the 
command.

When the command is started, enter the 
distance you want to offset in the Offset 
Amount entry field in the Toolbox.

Select a side of the rectangle.
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Move the mouse pointer around, and you will see a preview of the 
selected entity being offset.  When the preview is where you want the 
offset, click to create the offset entity.

You can now select another single entity, and create an offset by 
clicking when the preview is where you want the offset.

Right click to end the command when you have finished making 
single offsets.
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Offsetting a boundary

Delete the single offsets you made, or click on Undo till you return to 
the rectangle with filleted corners.

Click on the Parallel/Offset icon in the Line menu to start the 
command.

Enter the distance you want to offset in the 
Offset Amount entry field in the Toolbox.

Select  the same side of the rectangle.
The single offset preview will appear, but do not click to place it.
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Move the mouse pointer near the end of the selected line, and the 
connected boundary will be highlighted.  Click to select the boundary 
for offsetting.

Now the preview will show a preview of the entire boundary being 
offset.  Click to place the offset.  The command will recur.

Right click when you have finished creating offsets.

Select All and Delete before continuing.
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Moving Entities

Entities can be moved, copied, scaled, rotated and mirrored.
These Transform functions can be accessed by clicking on the 
Transform icon in the Toolbox to open the Transform menu.

We will start with the Move command.  Use grid snaps to draw a 
square evenly spaced around the world origin, and draw two circles 
on the corners at the left of the square.

Before starting a Transform command, entities must be selected.
Click on the Select icon to select entities one at a time.

Click on each of the circles to select them.  Selected entities change 
color to red when they are selected.  If you select an entity by 
mistake, click on it again and it will be removed from the selection 
set.

Right click to finish selecting.
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Click on the Transform icon to open the Transform menu in the 
toolbox.

The Move icon in the Transform menu is highlighted, showing that the 
Move command is started automatically.

You can select or enter a position as the start point for a move.  Click 
on the midpoint of the line between the circles.

A preview of the entities being moved will be attached to the mouse 
pointer.  Shadows indicate the original position of the entities.  Click 
on the midpoint of the opposite line to move the circles.

Right click to end the Move command.  The moved entities are 
still selected, ready for another command.
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Click Deselect All to leave the circles unselected.

Copy Entities

Click on the Select icon, and select the circle at the top of the square.

Right click to end the selection.

Click on the Copy Move icon in the Transform menu of the toolbox to 
start the Copy command.
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Select the intersection of the circle and the right side of the square as 
the start point of the move.

Move the mouse pointer to the left side of the square.  Click on the 
intersection of the left side of the square and the dashed horizontal 
indicator to set the finish point of the move.

Right click to end copying from the current start point.

The Copy move command is still active.  Select the center of the circle 
as the start point for another copy.
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Click on the diagonally opposite corner of the square to create a copy 
there.

Right click to end the current copy.

Right click again to end the Copy move command.

Click Deselect All to leave the original circle unselected.

Rotate

Entities can be rotated about a selected center of rotation.  The axis 
of rotation can be parallel to the X, Y, or Z axis of the World or Plane 
coordinate system.

Select all the sides of the square.

Right click to end the selection.
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Click on the Rotate icon in the Transform menu.

To select the center of rotation, move the mouse pointer to the 
intersection of the X axis and Y axis.  Click when the square World 
origin indicator appears.

To create the rotated square as a copy of the 
original, enter 1 for the #Copies value in the 
Toolbox.

The toolbox now shows six options for the axis of rotation.  The 
default rotation mode is Rotation Z plane, which rotates entities in the 
current drawing plane.

You can enter the exact degrees of rotation in any of these fields, but 
for common rotation amounts a rotation protractor with markers at 
15° intervals is shown in the drawing window.
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Move the mouse pointer around the protractor, and click to rotate the 
square by 45°.
 

Right click twice to end the rotation command.

Click Deselect All to leave the original square unselected.

Setting Current Drawing Properties

OneCNC has a 2 color drawing system, controlled by color selection 
boxes in the Status Bar.

The color selector on the left is for geometry and that on the right is 
for surfaces and models.  To set the current color, click the selector 
and select the color you want to use.  To switch back to the default 
color just click the small square in the corner of the selector.

To select the line style and line thickness you would like all new 
entities to be drawn with, click the Styles icon.

OneCNC uses red to indicate an object is selected, so don’t use red 
for drawing. 



Page 62 Introduction to OneCNC WireEDM ©

Using Layers

Every entity created in OneCNC is said to be ‘on’ a Layer.  Layers give 
you control over entities on each layer as a group.  For example, if 
you draw dimensions on a layer named ‘Dimensions’, you can then 
turn off display of the layer to hide all dimensions while working on 
the drawing geometry.

Click on the Layer tab at the lower right of the screen to open the 
Layer Manager.

Up till now you have been working in a new file, on the default layer, 
Layer 1.  We will now create a new layer and move some of the 
geometry to the new layer.

To add a new layer, click on the + icon at the top of the Layer 
Manager.

The new layer is created with the default name Layer 2.  Click on the 
icon next to the + icon to rename the layer.
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Enter ‘Circles’ as the name for the new layer, and click OK.

The Layer list is sorted alphabetically, so the Circles layer is now 
above Layer 1.  It is highlighted in blue, indicating it is the active 
layer new entities will be created on, but the X in the visibility column 
shows it is an empty layer.

Select all the circles in your practice drawing.

Click on the Modify icon in the Status Bar.

Default Layers
You can set default layers  to be contained in each new drawing 
from the File menu > Properties dialog.  Select the Layers tab, click 
New, give the layer a name, and set a default color, line type, and 
width.
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In the Modify Selected Attributes dialog, you can change the color, 
line type, thickness, or layer of entities.  Select the Circles layer in the 
Layer list to move the selected entities to that layer.

There is now a green eye icon in the Circles layer visibility column, 
indicating all entities on the layer are visible.  The red selection 
square indicates all entities on the layer are selected.  Click on the 
square to deselect the circles.

Click on the open eye icon for the Circles layer and it will close.
This will turn off display of all entities on the layer.
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Now you will be able to see the squares clearly.

Trimming Entities

Trim functions are used to shorten or extend existing entities.

Scissors
The quickest way to trim away unwanted parts of geometry is to use 
the Scissors tool.

Click on the Trim/Break icon in the Toolbox to open the Trim/Break 
menu.

Click on the Scissors icon to start the Scissors command.

Click on an unwanted part of a line or arc.
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The geometry will be trimmed back to the next intersection with 
another line or arc, and the command continues.  You can continue 
trimming by clicking on unwanted parts of geometry.  

Right click to end the command when you have finished trimming 
entities.

The Scissors command cuts entities back to the next intersection or 
endpoint in each direction from the point where you clicked on the 
entity.  If you click on an entity which is not crossed by another line 
or arc, it will be deleted.
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Trim Two

This function will shorten or extend two arcs or lines to their common 
intersection.  It is an important function as it can be used to make 
sure a chain of entities are properly connected at their endpoints.

Open a new file to practice using the Trim Two command.  Draw some 
lines that cross, and some unconnected lines.

Start the Trim Two command by clicking the Trim Two icon in the Trim 
menu of the Toolbox.

Click on the first line you want to trim, on the side of the intersection 
that you want to keep.
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Click on the second line you want to trim, on the side of the intersection 
that you want to keep.

The lines will be trimmed to their intersection.  In this example both 
lines were shortened.

The command continues, and you can click on the next line you want to 

trim.
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Click on the next line to trim.  In this example one line will be 
shortened and one will be extended to meet at their intersection.

Right click to end the command when you have finished 
trimming.  The four lines in this example have now been trimmed 
to form a closed boundary.

 

Click Select All and then click the Delete icon to clear the 
drawing area.

Some CAM operations require selection of consecutive entities as a 
profile chain.

Trim Two ensures that the junction between two entities is properly 
trimmed for chain selection, and can be used to repair a chain that 
will not select properly.
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Chain Selection

Chain selection is an important function that selects consecutive 
entities to form a profile chain.  A profile chain can be open or closed.
For many CAM functions you will need to select a profile chain of 
consecutive entities as the first step of the toolpath definition.
  

To practice chain selection, draw a filleted rectangle.

Selecting a complete profile as a chain

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.
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Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.

The mouse pointer changes to the word ‘end’.  Click on the last entity 
of the chain you want to select, or press the F3 key to select all 
consecutive entities automatically.

The chain will be selected.  You can now start to select another chain, 
or right click to end chain selection.
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Selecting part of a profile as a chain

Click on the Deselect All icon to clear the previous selection.

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.

Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.
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The mouse pointer changes to the word ‘end’.  Click on an entity to 
end the chain.

The mouse pointer is still seeking a chain end.  You can click further 
along the chain to add one or more entities to the chain selection.

Right click when you are ready to finish selecting the chain.  You can 
now start to select another chain, or right click again to end chain 
selection.
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OneCNC CAD Tutorial 2
2D Drawing

This Tutorial is designed for all OneCNC products.

In this tutorial we will be using some of the time saving features of 
OneCNC CAD drawing to show how easily a part can be constructed.  
We will be drawing a part with fillets and chamfers, and a slot at an 
angle of 75 degrees.

Start a new file, and save it as ‘Cad Tutorial 2’.

Click on the View icon in the Status Bar to open the View menu, 
and select CAD View.

CAD view is a special top down view, specifically for 2D drawing in the 

XY plane.
While in CAD view all drawing is in World coordinates.
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Step 1: Draw outer profile

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.
Enter 0 for Corner Radius, to draw the rectangle with sharp corners.  

Enter coordinates in the toolbox or use a grid snap to start the 
rectangle at X10 Y10.  You can then enter 150 for Length and 100 for 
Height to make the rectangle 150 wide in X and 100 high in Y.

To create the semi-circle on the right side of the part, start the Arc 

Sketch command on the Arc menu.

Click on the midpoint of the vertical line at the right side of the part to  

locate the center of the arc.
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The Arc Sketch function now requires the arc Radius, Start Angle, and  
End Angle.  Each of these can be defined by entering a value in the 
toolbox, or clicking on an entity or grid snap.

Enter 15 in the toolbox for the Radius of the 
arc.

Click on the endpoint above 
the arc center to set the 
Start Angle to 90°.

Click on the endpoint below 
the arc center to set the End 
Angle to 270°.
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Right click to end the Arc Sketch command.

To draw the angled line at the top left of the part, select the Line 
menu to start the Line command.

Click on the vertical line at the left of the part, between the midpoint 
and upper end.

To fix the start point of the line at 40mm from 
the end of the selected line, enter 40 as the 
Distance along value in the toolbox.
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Enter -60 for the Line Angle.

This will fix the angle of the new line at 60° 
from the direction of the anchor line.

Move the mouse pointer along the new line preview until it locks onto 
the horizontal line at the top of the part, and click to draw the line.

Right click to end the Line command.

We can now trim away the unwanted line segments.
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Start the Scissors command on the Trim/Break menu.

Click on the segment within the semicircle to remove it.

Click on the segments at the top left of the part to remove them.

Right click to end the Scissors command.

Next we will create the fillet on the lower left corner of the part.

Start the Fillet command on the Arc menu.
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Enter a Fillet Radius of 25 in the toolbox.

Click on the left side of the 
part near the lower left 
corner.

Click on the lower side of 
the part near the lower left 
corner.

The fillet is created, and 
the corner is trimmed 
automatically.

Right click to end the Fillet 
command.



Page 81Introduction to OneCNC WireEDM ©

Next we will create the chamfer on the lower right corner of the part.

Start the Chamfer command on the Line menu.

Enter a Chamfer Distance of 15 in the toolbox.

Click on the lower side of 
the part near the lower right 
corner.

Click on the right side of the 
part near the lower right 
corner.

The chamfer is created, 
and the corner is trimmed 
automatically.

Right click to end the 
Chamfer command.
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Step 2: Draw the angled slot

The first step in construction of the slot will be to draw the centerline.

Select the Line menu to start the Line command.

Move the mouse pointer near the center of the fillet arc, and click to 
place the start point of the line there.

Type 25 in the Line Length box, and press 
Enter.

Type 45 in the Line Angle box and press Enter 
again.

The line will be drawn.

Right click to end the current Line sequence, and right click again to 
end the Line command.
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The part drawing should now look like this.

Start the Circle command to draw circles which will become the arcs 
at each end of the slot.

Type 10 in the Diameter entry box.

Click on the lower endpoint of the centerline to draw the first end arc 
of the slot.
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Type 20 in the Diameter entry box.

Click on the upper endpoint of the centerline to draw the second end 
arc of the slot.

Right click to end the Arc command.  You should now have two 
circles of unequal diameter, one at each end of the centerline. 
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Next we will join the circles with tangent lines.

Start the Line Tangent command in the Line menu of the Toolbox.

Draw the first tangent line by clicking near where the tangents will be.

Draw the second tangent line by clicking near where the tangents will 
be.

Right click to end the Line Tangent command 
and you will have two tangential lines as 
shown here.
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Begin the Single Selection command.

Select the 45 degree centerline.

Right click to end the selection process.

Click the Delete icon or press the Delete key to delete the 
centerline.

All we have to do now is trim the circles to 
the tangent lines to finish the slot.

Start the Scissors command on the Trim menu.
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Click on the unwanted segment of the lower circle to trim it away.
Circles have an endpoint at 0° so you must click twice to remove both 
ends of it.

Click on the unwanted segment of the upper circle to trim it away.
The remaining arc will be composed of two arcs because of the circle 
endpoint at 0°.  It is good practice to trim this to one arc.  Click below 
the 0° endpoint to remove the smaller arc.

Because the smaller arc is not crossed by 
any other entity, the Scissors command 
removes it completely. 

Right click to end the Scissors command.
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Start the Trim Two command.

Click on the tangent line to select it as 
the first entity to trim.  Click between the 
endpoint and the midpoint of the line.

Click on the arc to select it as the second 
entity to trim.

The two entities will now be joined perfectly.

Your drawing should now look like the picture at the beginning of this 
tutorial, which is now complete.  
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This tutorial is intended for Expert and Professional versions of OneCNC.

In this tutorial we will use OneCNC solid extrude commands to 
construct a 3D solid part.  You will need the outlines drawn in CAD 
Tutorial 2 before attempting this tutorial.  We will extrude the part 
with a taper angle and cut the through slot with vertical walls.

Step 1: Complete CAD Tutorial 2 and save a copy.

Complete ‘CAD Tutorial 2’ and save the file.  Use Save As on the File 
menu to save a copy as ‘CAD Tutorial 3’.  Press the Space bar and 
set the view to Trimetric.  Your part should appear as shown in this 
image.

OneCNC CAD Tutorial 3
Solid Modeling by Extrusion
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Step 2: Create a solid by extrusion from curves.

Click on the Extrude icon in the Toolbox to open the Extrude menu.

Click on the Extrude Curves icon.

Enter a Taper Angle of 15 in the parameters 
section of the Toolbox.  This will tilt the walls of 
the extrusion inwards.

Leave the Linear Corners check box 
unselected.

OneCNC now seeks a 
boundary to create an 
extrusion from.  Hover the 
mouse anywhere near the 
external boundary and click 
to select it as the outline of 
the part.  The entire outer 
boundary will be selected 
with one click.

You can extrude a shape 
with one or more openings, 
so the cursor will continue 
to seek boundaries.

Do not select the inner 
boundary.

Right click to end the selection stage of the command because in 
this case we want to create the slot using different settings.
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The height of the extrusion can be set by a mouse click or by entering  
the height in the toolbox. As you move the mouse, you will see a 
preview of the extrusion, and the current height will be displayed in 
the toolbox height entry.

Enter a Height of 10 in the parameters section 
of the Toolbox, and press the Enter key.

Click in the drawing window and the extruded solid is created with an 
external taper of 15 degrees.

Right click to end the command.
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Step 3: Create the slot with an extrude cut

The slot boundary we want to use is obscured by the solid we have 
made.  We could change the view direction but there is no need to do 
this, as we can change the model display setting to Transparent.  

Click on the Display icon to open the Display menu.

Select Transparent.  The slot geometry will now be visible 
through the part.

Click on the Extrude cut icon in the Extrude menu.

Change the Taper Angle to 0 so the slot will 
have vertical walls. 

Select the internal boundary to create the cut extrusion.
Only one boundary can be used for an Extrude cut so you do not have 
to right click to end the boundary selection.
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Because we want a through cut the exact extrusion distance is not 
important.  Move the mouse pointer up until the extrusion preview is 
above the part, and click to make the extrude cut. 

Right click to end the Extrude Cut command.

Click on the Display icon and change the display mode back to 
Normal.

To see how you can create a section view of your model, open the 
Section Tool topic in OneCNC Help.
You can find the topic in Help Contents -> CAD Drawing and 
Modeling -> Modeling Tools -> Section Tool.
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All new line and arc geometry, and surface and solid models, are 
created in the current construction coordinate system, which is 
independent of the world coordinate system.

When you open a new file in OneCNC, the current construction plane 
is the XY plane.  The X and Y axes of this plane coincide with the X 
and Y axes of the world coordinate system.

A transparent rectangle indicates the position and orientation of the 
XY plane of the current construction coordinate system.  The Origin 
selector at the right of the Status bar shows World coordinate input is 
active.

Clicking on the Origin selector will activate Plane coordinate input.
A plane origin indicator will appear.

OneCNC CAD Tutorial 4
Working With Planes
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As an introduction to Plane functions we will position a Plane as an aid 
to constructing a truncated wireframe pyramid.

Step 1: Draw a pyramid wireframe

Start a new file, and save it as ‘Cad Tutorial 4’.

Select World coordinate input, and use the Rectangle command to 
draw a square from X0 Y0 to X100 Y100.

Start the Line command, and click on the corner of the square to start 
the first edge of the pyramid.
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Enter World coordinates as shown to end 
the edge at the vertex of the pyramid.

Click on an adjacent corner of the square to finish the second edge of 
the pyramid.

Right click to end the current Line sequence, and construct the other 
two edges by clicking on corner, vertex, and corner.
Right click twice to end the Line command.
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Step 2: Position the plane

Open the Planes dialog by clicking on the Plane icon in the Status 
Bar.

In the Planes dialog you will see the XY 
Default Plane is selected in the Saved 
Planes list.

You will also see the pre-defined YZ and 
XZ planes.

The Display active plane check box must 
be selected for the plane to be visible.

Click on the Push or Pull Plane icon in the Planes dialog.

This command will move the current plane up or down along its Z 
axis.

Enter a drag amount of 50, and click OK.

The plane will be moved vertically by 50mm.
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Click on the Origin selector to activate plane coordinates.
The Plane origin indicator shows the origin of the moved 
plane.

We will now tilt the plane on its own Y axis to create the angle for 
truncation of the pyramid

Click on the Plane icon again to open the Planes dialog.

Click on the Rotate Plane icon.

The plane can be rotated around the World axes or its own axes.

To rotate the plane around its own Y axis, enter 15 in the Plane Y tilt 
entry box and click OK.
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The plane is tilted on its own Y axis.  The plane origin will still be 
directly above the World origin.

We will save this plane position so we can return to it easily.

Step 3: Save the plane position

Click on the Plane icon again to open the Planes dialog.

Click on the Save icon.

Name the plane Truncation plane and click OK.
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The plane now appears in the Saved 
Planes list.

Step 4: Create the truncated pyramid

To truncate the pyramid edges, open the Trim menu in the Toolbox, 
and click on the Trim to plane icon.  This command trims lines or arcs 
which pass through the plane to the plane intersection.

Click on an edge of the pyramid, between the base and the plane.

The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.
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The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.

Continue until all four lines are trimmed to the plane.

When you have trimmed all four side edges of the pyramid, use the 

Line command to join them.  These lines form the boundary of the 
truncation.
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Step 5: Return to default XY plane

To return to the XY plane, open the 
Planes dialog and select the XY plane in 
the Saved Planes List.

To return to World coordinate input, 
clear the Use plane coordinate system 
check box before clicking OK.

You will see the XY plane is 
current again.

You can return to the 
truncation plane by 
selecting it in the Saved 
Planes list.

To learn more about plane commands in OneCNC, go to ‘Construction 
Planes’ in the CAD section of OneCNC Help.
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This tutorial is intended for Expert versions of OneCNC, and Solid Creator.

Automated 3D model to 2D CAD drawing is a standard feature of 
OneCNC Solid Creator and OneCNC Expert versions, and can be added 
as an optional module to OneCNC Mill Professional.

Traditionally, a technical drawing was the first step in production of a 
part.  Now, you can design the part as a 3D model, and create one or 
more technical drawings automatically from the part.

The paperspace drawings are associated to the model, so if the design 
changes, you can change the part model and then update the drawing 
views automatically to show the revised part.

There are two stages to creating a technical drawing in OneCNC.
The first step is to create a drawing page layout with title block and 
border.  You can then create and manage views of your model in the 
layout.

OneCNC Technical Drawing
Automated 3D to 2D Drawing Layouts
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Add a drawing page with border and title block

To add a new page, click on the Pages icon in the Status Bar.

The Page Manager dialog will open.

Click on the Add page 
icon to open the Page 
Setup dialog.
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Templates are supplied for standard paper sizes with pre-drawn 
borders and title blocks. Select a template for the paper size you want 
from the Templates list, and enter a name for the page.

The Auto fill template section contains entries which can be 
automatically added to your title block. Fill these out as necessary, 
and click OK.

The new page now appears in the Pages list in the Page Manager.

The selected page will be seen in the main drawing window, with the 
title block showing the details input in the Page Setup dialog.  You can 
now place views from the Views list into the new page.

To return to the main drawing environment, select Model Space in the 
Pages dialog.
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Add views of the model to a drawing page layout

You can add a view of the model to an existing drawing page layout at 
any stage of the design process.

In the Pages list of the Page Manager, select the page layout you want 
to add the view to.

Select the view in the Views list, and a preview of the view will appear 
in the lower section of the Page Manager dialog.

Click the Place view on page icon to add the view to the page.
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The view will be attached to the cursor.  Click to place the view when 
it is in the position you want.

After placing the view, you are returned to the Pages Manager again, 
and you can continue placing views as necessary.

Views are not restricted to orthogonal representations. An Isometric 
view gives a good indication of what the part actually looks like.
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You can create a section view in the Views list using a plane 
positioned where you want the section.

You can also use a plane to define a view from a specific direction.

Views and section views can be dimensioned as necessary to 
complete the drawing.

Using the 3D to 2D Technical Drawing module you can quickly create 
professional drawings to recognized standards.  For more detail on 
using the module see the Automated 3D to 2D drawing topic in the 
CAD section of OneCNC Help.
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OneCNC WireEDM Tutorial 1
2 axis closed profile

These tutorials describe how to use OneCNC Wire EDM to efficiently 
generate wire-cutting operations for EDM machines.

The workflow for wire path generation from geometry requires a 
defined start point and a profile which can be closed or open.  For 
open profiles you will also need an end point.

Complete CAD Tutorial 1 before attempting this tutorial, in which we 
will generate a wire path for a closed profile, and output the NC code 
to cut the profile.

Create a new part file and draw a filleted square.

Start a new file and save it as ‘Tutorial Wire 1.ONECNC’.
Set the drawing view to the CAD view.

Using the Rectangle tool, draw a square with a corner radius of 10.  
Start the square at X3 Y3 and make it 60 wide and 60 high.



Page 110 Introduction to OneCNC WireEDM ©

Create a Wire start point.

We will create a wire start point at the XY origin.

Click on the Point icon in the Toolbox Home menu.

The Point command will be started automatically.

Click on the grid snap at the part origin to create a wire start point at 
X0 Y0.

Right click twice to end the Point command.
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Creating a Closed Profile Wirepath.

Click on the Toolpaths icon in the Toolbox.

Click on the Cut closed profile icon in the Toolpaths menu.

Click on the point at X0 Y0 to select it as the start of the operation.

Click the fillet radius closest to the wire start point.  This will be where 
the wire begins to cut the profile.
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The radius will be selected and the cursor will change to direction 
arrows.  

Hold the cursor outside the profile and above the profile start point so 
the arrow points in a clockwise direction around the profile.

Click to set the cut direction.

The cursor now changes to the End cursor.

Click on the last segment of the profile to be cut.

Instead of clicking on the last segment, you can press F3 on your 
keyboard to select the consecutive chain automatically.
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The closed shape dialog appears.  The wire path settings are 
categorized into sections.  Fill out the settings as follows:

Passes:
This section controls the settings for multiple passes.  For this 
example set Number of Passes to 2.  In the white text box you can 
enter code to set machining parameters for each pass.

The pass the code is for is selected by 
clicking on the bar at the top of the text 
box.

For this example enter a bracketed 
comment (Pass 1) for Pass 1 and (Pass 
2) for Pass 2 so you will see where the 
code occurs in your output NC program.  
Leave the Prefer single direction box 
unchecked. 
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Cut Off:

Select the Standard option for Cut Off.

This is the simplest setting, which will 
complete the profile and return the wire to 
the start point.

Compensation:
Set this to Machine compensation.

In this mode the compensation G41 
or G42 codes will be written in the NC 
program.

This allows changes to the wire diameter 
to be made at the control without 
regenerating the NC code in OneCNC. 

Taper Angle: 

For machines with Taper angle programming you can 
enter the taper in degrees when you want taper in 
the NC program.

Leave this option unchecked for this example.

Approach/Depart: 

This section allows insertion of special codes at the 
beginning of a program.  For this example leave start 
code at Rapid and the Auto threading and wire cut 
boxes unchecked.
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Blending:

Blending options are available for the Standard and 
Glue Gap Cut-off functions.  Set blending to None 
for this exercise, so that the wire contacts the profile 
without any adjustment.

Spiral Roughing:

This section of the dialog is grayed out as it is only 
applicable when cutting a hole. 

Once all the settings are entered click OK.

The path for the closed shape will 
be created, and appear in Toolpath 
Group #1 in the NC manager.
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Previewing the wire path.

So far we have stayed in CAD view, the default view for a new file.

The Preview window opens with the same view as the drawing 
window, so we can preset the appearance of the preview by changing 
the drawing view.

Press the Spacebar and select Trimetric from the View menu.

Right click the closed shape 
operation in the NC Manager, and 
Select Preview Toolpath from the 
drop down menu.



Page 117Introduction to OneCNC WireEDM ©

The Live Preview window appears, and simulates the wire toolpath.

Use the video controls to play, pause or rewind the operation.

The controls at the top of the toolbox allow you to change the view 
and zoom magnification.  

The current coordinates of the  wire are displayed in the top right 
corner.

The simulation speed control is in the lower left corner of the preview 
window.

Close the Live Preview when you are ready to continue.
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Posting NC Code.

You can output an NC program for a single wire toolpath operation, or 
for a toolpath group.

 
Select the Closed Shape toolpath and 
click on the Process icon at the top of 
the NC Manager.

This opens the Process dialog which has controls and tools for Post-
processing your program.

For most CNC machines the basic NC program G and M codes follow 
the ISO standard.  Other codes vary between controllers so OneCNC 
must format the code when the NC file is output.  The format 
setting is called a ‘Post’, which is short for post-processor.  OneCNC 
is supplied with prepared Posts for most machines.

To edit a Post, click on Setup to open the NC Post Settings dialog.  
See ‘Mill NC Post and DNC Settings’, in the OneCNC Mill CAM section 
of the Help files for more information.
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Click on the drop down list to select the Post for your machine.

The text fields allow input of information such as the name of the 
operation, program and part numbers, and notes.

If the part origin on your machine is not the same as your part 
origin in OneCNC, you can use the Workshift function to relocate the 
program to suit.  For example if the corner of your part is at X20 Y50 
on the machine enter a workshift of X-20 Y-50 to correct the position.
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Click on the Post icon to output the NC program.  

The Save As dialog appears.  Choose the directory to save the file to, 
and enter a name for the file.  Select the file type from the drop down 
menu on the Save As dialog.

Your NC file opens in OneCNC Link,  which is an independent text 
editor and RS232 communications program.

You will see the (Pass 1) and (Pass 2) comments from the Passes 
input box where each pass begins.
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Click on the Send icon on the OneCNC Link Standard toolbar to open 
the communication dialog for your machine.  

Comprehensive information on how to use the OneCNC Link NC Editor, 
and setup communications, is available in the OneCNC Link Help files.

Note:

When you first start using OneCNC you should check through the 
output to make sure it is formatted the way you want for your 
machine.  Once your format is tested on the machine you can post 
and send files with confidence.
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OneCNC WireEDM Tutorial 2
2 axis open profile

In this tutorial we will use part of the closed profile as an open profile.  

Prepare the drawing

The wire returns to the start point when cutting a closed profile.  For 
an open profile we need a separate end point for the wire to finish at.

Click on the Point icon in the Toolbox Home menu.
The Point command will be started automatically.

We will create the wire end point at an exact coordinate, using the 
coordinate entry panel in the toolbox.

Type 66 for the World X Coord value, and 
press Enter.

Leave the World Y Coord value at 0, and 
press Enter.

Leave the World Z Coord value at 0, and 
press Enter.
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A wire end point is created at X66 Y0.

Right click to end the Point command.
We could create the open profile operation by only selecting part of 
the closed profile, but for clarity we will blank the adjacent sides.

Start the Single selection command.

Select the vertical lines at either side of the square.
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Click on the Blank icon in the Transform menu.

The sides are hidden so we can work on the lower part of the outline 
as a separate profile. 

Creating an Open Profile Wire toolpath.

Click on the Toolpaths icon in the Toolbox, and click on the Cut open 
profile icon in the Toolpaths menu.

Click on the point at X0 Y0 to select it as the start of the operation.
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Click on the arc on the left to specify the start of the profile chain.

Hold the pointer to the left to pick the outside of the profile for the 
wire offset.
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Click on the arc on the right to specify the end of the profile chain.

Right click to end the profile selection stage, and pick the point at X66 
Y0 for the end position of the operation.
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The Open Shape dialog will open.

Select 1 for Number of Passes and Automatic compensation.

Select Standard Cutoff and Circular Blending.  Enter a radius of 2 for 
the blending radius.

Click OK and the wire toolpath will be created.
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Right click on the Open Shape 
toolpath in the NC Manager, and 
select Backplot.

Here is the wire toolpath as it appears with the Standard Cutoff and 
Circular Blending radius of 2.

The wire toolpath can now be previewed and posted in the same way 
as the closed profile wire toolpath.
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To make the blanked lines visible 
again, click on the eye icon for the 
layer in the Layers Manager and all 
objects on that layer will be visible 
again.

In this example we blanked the adjacent segments of the profile so it 
was clear what we were selecting.

You can select an open profile which is part of a closed profile by only 
selecting the start and end entities you want to use for the toolpath.
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In this exercise we are going to generate a 4 axis wire toolpath on a 
solid model and include a glue gap.

Open the sample file and save a copy to practice in.

There is a Samples folder in the Drawings folder where you installed 
OneCNC.  Open the sample file ‘A3 Wire 4 Axis With Glue Gap.
ONECNC’, and save a copy of the file as Tutorial Wire 3.

Delete the existing wire toolpath in the NC Manager.

OneCNC WireEDM Tutorial 3
4 axis solid model with glue gap
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Creating a 4 axis Wire toolpath with glue gap.

Click on the Toolpaths icon in the Toolbox, and click on the 4 axis cut 
icon in the Toolpaths menu.

Like a closed or open profile wire toolpath, the 4 axis wire toolpath 
requires a start position.  Click on the point entity to the right of the 
model.

You are prompted to pick a position on the model.  This point will 
define the first connection, or join from the bottom profile to the top 
profile.  It is not necessarily where the cut will start.

Click the surface endpoint at the base of the model as shown in the 
image.
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The wire toolpath side and direction indicators appear.  

Hold the cursor outside the model and on the far side of the start 
point, and click to set the side and direction.

The 4 axis wire cut dialog opens, as there are no other selections to 
make for a 4 axis toolpath.

In the Cut Off section of the 4 axis 
wire cut dialog, select the Glue 
gap option.

This will add machine stops to the 
last stage of the program.

Enter a Gap distance of 2.
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Select 1 for the Number of passes, and Automatic compensation.  
Select None for Blending.

Click OK and the machining operation will be created.
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Right click on the new wire toolpath and select Preview Toolpath.  
You will see the wire move directly to the model, travel to the first 
connection, and then continue around the perimeter, maintaining 
continuous contact with the 3D surface as it does so.
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Post the wire toolpath.

Post the NC file using your preferred post settings.
Press Ctrl and End simultaneously to jump to the end of the file.  You 

will see an M00 program stop at Y-2 with an optional M01 stop at Y0.
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In this exercise we demonstrate OneCNC’s ability to create a 4 axis 
program using only wireframe geometry without a solid model.

Open the sample file and save a copy to practice in.

Open the ‘A5 4 axis Wire No Model.ONECNC’ sample file and save a 
copy as Tutorial Wire 4.  Delete the existing wire toolpath in the NC 
Manager, and select the Trimetric View.

OneCNC WireEDM Tutorial 4
4 axis from wireframe drawing
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Note that a start point has been sketched near the Y axis on the Y- 
side of the wireframe model.

Creating a 4 axis Wire toolpath.

Click on the Toolpaths icon in the Toolbox.
Click on the 4 axis cut icon in the Toolpaths menu.

The Status bar prompts you to select the start position.  Click on the 
point entity located below the wireframe as shown.
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The Status bar now prompts you to pick a position on the model or 
wireframe.

Click on the intersection to the right of the start point.  This point will 
define the first connection, or join from the bottom profile to the top 
profile.

The direction and side indicator arrows appear.  Position the pointer so 
the direction arrow is outside the wireframe model and pointing to the 
right, and click to set the side and direction.
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The 4 Axis wire cut dialog appears.

Select 1 for the Number of passes, and Automatic compensation.  
Select None for Blending.

Select the Standard option for Cut Off.

Click OK and the wire toolpath will be created.
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Backplot the wire toolpath. 

The wire toolpath operation is now listed in the NC manager.  The 
operation will be displayed in the main drawing window while the 
operation is selected.

To draw the wire toolpath as 
geometry, right click the ‘1:4Axis 
Wirecut’ operation in the NC manager 
and select Backplot.

The wire toolpath geometry is created on an automatically generated 
Layer named Backplot.



Page 141Introduction to OneCNC WireEDM ©

To create the correct shape as the wire moves around the corner arcs, 
the toolpath must be converted to line movements.

The wire toolpath appear solid on the corners, because the default 
tolerance setting creates a smooth curve by keeping the size of the 
line moves very small.

Setting Interpolation Tolerance

The resolution of wire toolpath movement on arc entities is controlled 
by the Interpolation Tolerance setting in the NC Post Settings dialog.

To change the setting, click NC Setup in the NC menu to open the NC 
Post Settings dialog.
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On the left side of the General tab you will find the Circular Movement 
section.

The default setting for Interpolation Tol is 0.001, which will give you a 
smooth wire toolpath.

To see the effect of this setting, change the Interpolation Tol value to 
0.01, and click OK to close the NC Post Settings dialog.
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Rename the existing Backplot layer to 
Backplot 0.001, and turn it off.

Backplot the ‘1:4Axis Wirecut’ operation in the NC manager and you 
will see the wire toolpath resolution has been reduced.

You can turn on the original backplot layer to compare the results.

Reset the Interpolation Tol value to the default tolerance setting of 
0.001 before continuing.
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Editing the start point.

The 4 axis wire toolpath we created on the solid model in the previous 
tutorial started with a perpendicular move from the start point directly 
to the flat surface. 

The wire toolpath we created in this tutorial starts with a move to the 
line connecting the top and bottom profiles.
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In the top view you can see that it is not possible to draw a line from 
the existing start point entity perpendicular to the horizontal line of 
the upper profile.

Because the start point lies across the connection, the wire toolpath 
will start on the connection itself.

For the wire to approach the job directly we must use a start point 
perpendicular to both segments between a pair of connections.
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Create a new start point using the Copy move command to copy the 
start point at an increment of X-5 from the original start point.

Right-click the ‘1:4Axis Wirecut’ operation in the NC manager and 
select the Repick Path option.

Pick the new start point, then select the lower profile exactly as 
before.

You will see the wire toolpath update with the approach moving 
directly to the flat side of the job.
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Correcting profile geometry

The wire toolpath consists of movements from connection to 
connection along geometric entities in an upper and lower profile.

If the number of entities between connections in each profile differs, 
the wire toolpath must compensate by creating excess interpolation 
points.

We will demonstrate this effect by dividing an arc in the lower profile 
into two segments.

To make the effect obvious, change the 
interpolation tolerance to 0.1.

Select the toolpath and the instant preview will show the coarse 
interpolation setting.
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Click on the Divide entity icon in the Trim/Break menu.

Click on the lower arc as shown.

Enter 2 to divide the selected arc into 2  consecutive arcs of the same 
radius.

Click OK, and then right click to end the Divide command.

This corner will now have one arc in the top profile and two arcs in the 
bottom profile.
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To update the wire toolpath with the changed geometry, right-click the 
‘1:4Axis Wirecut’ operation in the NC manager and select the Repick 
Path option.  Pick the new start point, and select the lower profile 
exactly as before.

The backplot on the corner with unequal entities between the 
connections now appears solid as it is made up of many more lines.  

The NC output for this wire toolpath will produce the correct shape, 
but will contain many more lines of G-code.

Use the Divide command to divide the upper arc into two segments.  
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Use Repick Path to update the wire toolpath with the changed 
geometry again.

Now that the entity count for each profile matches again, the wire 
toolpath result will be normal.

Reset the interpolation tolerance to 0.001 before continuing.
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In this exercise we will create an open shape 4 axis program.  The 
open shape will cut part of a solid model, using wireframe geometry 
extracted from the model.

Make a copy of an existing drawing

Open the sample file ‘A9 4 Axis with Auto Offset.ONECNC’, and save a 
copy of the file as Tutorial Wire 5.

Press the Spacebar and select Trimetric View from the View menu.
This file has a solid model and construction geometry on separte 
layers.

OneCNC WireEDM Tutorial 5
4 axis open shape
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Prepare the drawing.

Click on the Extract an edge icon in the Model Tools menu.

Click on an edge where the top of the model meets a side.
The edge around the top will be extracted.

Click on an edge where the bottom of the model meets a side.
The edge around the bottom will be extracted.



Page 153Introduction to OneCNC WireEDM ©

Click on the seam at the right of the model as shown.
An edge will be extracted for the seam.

Click on the matching seam at the left of the model to extract the 
edge.

Right click to end the command.
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Turn off display of the Geometry and Model layers and you will see the 
geometry which has been created on the Extracted layer.

Delete the segments of the upper and lower profiles on the far side of 
the connecting lines.  We now have an open wireframe shape, but we 
still need to draw a start and end point.
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Click on the Point icon in the Toolbox Home menu.
The Point command will be started automatically.

We will enter the coordinate position using the coordinate entry panel 
in the toolbox.

Type 0 for the World X Coord value, and 
press Enter.

Leave the World Y Coord value at 0, and 
press Enter.

Leave the World Z Coord value at 0, and 
press Enter.

A wire start point is created at X0 Y0.

Type 100 for the World X Coord value, and 
press Enter.

Leave the World Y Coord value at 0, and 
press Enter.

Leave the World Z Coord value at 0, and 
press Enter.

A wire end point is created at X100 Y0.

Right click to end the Point command.
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We now have a start and end point and we are ready to create the 
open wire toolpath.

Create a 4 axis open shape wire toolpath.

Right click the existing operation in 
the NC manager and select Delete 
Operation.

We will create our new wire toolpath 
in Toolpath Group #1, which is now 
empty.
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Click on the Toolpaths icon in the Toolbox.
Click on the 4 axis cut icon in the Toolpaths menu.

The Status Bar prompts you to pick a start position.  Click on the 
point at X0 Y0.

Click on the left end of the lower profile to select it as the start of the 
cut profile.
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Hover the cursor to the left of the profile to indicate the direction and 
offset side for the wire toolpath, and click to confirm the selection.

Click the point at X100 Y0 to select the end position.
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The 4 Axis wire cut dialog appears.  Select 1 for the Number of 
passes, and Automatic compensation.

Select the Standard option for Cut Off.  Select Circular Blending and 
enter a radius value of 2.

Click OK and the wire toolpath will be created.
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An alternative method.

We have demonstrated OneCNC’s ability to create an open operation 
using the wireframe method, but it is also possible to create 4-axis 
operations on open surface entities.

Another way of achieving the same result would be to create a copy 
of the model on a new layer, and use the Break to Surfaces model 
operation to separate the solid into surfaces.  The surfaces we did not 
want to cut could then be blanked or deleted.

The 4 axis wire toolpath could then be defined on the surface shapes 
in the same way as it was for the wireframe.
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For assistance contact the OneCNC office for your location.

If you are emailing a support question, it will help us to help you if 
you zip and attach the file you are having a problem with, and include 
the following information:

Client Number
Click on Help > About OneCNC.  Your client number is a five digit 
number with the prefix CN. The number is the same as your dongle 
number.

Version
Click on Help > About OneCNC to find the exact version you are 
running, e.g. 62.79

OneCNC product
The type and level of OneCNC such as Mill Expert.

Units
Please let us know if the file is drawn in metric or imperial units.

OneCNC Support
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Australia
				   OneCNC Australia

		  Phone 		  +61 (0)7 3286 2527
		  Fax 		  +61 (0)7 3286 4992
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.com.au 

Benelux
				   OneCNC Benelux

		  Phone		  +31 (0) 40 22 66 212
		  Fax		  +31 (0) 40 22 40 794
		  Email		  support@onecnc.nl
		  Internet	 www.onecnc.nl 

Denmark
				   OneCNC Denmark

		  Phone		  + 45 20 40 02 68
		  Fax		  + 45 20 40 02 68
		  Email		  support@onecnc.dk
		  Internet	 www.onecnc.dk  

France
				   OneCNC France

		  Phone		  + 33 (0)4 72 33 38 74
		  Fax		  + 33 (0)4 72 91 42 92
		  Email		  support@onecnc.fr
		  Internet	 www.onecnc.fr

Germany
				   OneCNC Germany

		  Phone		  +49(0)5261 288940
		  Fax		  +49(0)5261 2889449
		  Email		  support@onecnc.de
		  Internet	 www.onecnc.de

India
				   OneCNC India

		  Phone		  +61 7 3286 2527
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.in

Indonesia
				   OneCNC Indonesia

		  Phone		  +62 31 8411187
		  Email		  support@onecnc.id
		  Internet	 www.onecnc.co.id

OneCNC Global Offices
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Ireland
				   OneCNC Ireland 

		  Phone		  +353 7196 33200
		  Fax		  +353 7196 33500
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk 

Italy
				   OneCNC Italy

		  Phone		  +39 393 438 3373
		  Fax		  +39 178 271 6215
		  Email		  support@onecnc.it
		  Internet	 www.onecnc.it

Japan
				   OneCNC Japan

		  Phone		  +81 (0)72 760 3134
		  Fax		  +81 (0)72 760 3135
		  Email		  onecnc@onecnc.co.jp
		  Internet	 www.onecnc.co.jp 

Korea
				   OneCNC Korea

		  Phone		  + 82 31 695 7250
		  Fax		  + 82 31 695 7253
		  Email		  support@onecnc.kr
		  Internet	 www.onecnc.kr

Mexico
				   OneCNC Mexico

		  Phone		  +52 (55) 85017429
		  Email		  esanchez@onecnc.com.mx
		  Internet	 www.onecnc.com.mx 

Portugal
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Poland
				   OneCNC Poland

		  Phone		  +48(0)22 388 3460
		  Fax		  +48(0)22 388 3461
		  Email		  support@onecnc.pl
		  Internet	 www.onecnc.pl
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South Africa
				   OneCNC South Africa 

		  Phone		  +27 31 7014732
		  Fax		  +27 31 7014736
		  Email		  sredman@iafrica.com
		  Internet	 www.onecnc.net

Spain
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Sweden
				   OneCNC Sweden

		  Phone		  +46 (0)35-7777030
		  Fax		  +46 (0)35-7777031
		  Email		  support@onecnc.se
		  Internet	 www.onecnc.se

Taiwan
				   OneCNC Taiwan

		  Phone		  + 886 2 26665010
		  Fax		  + 886 2 26660917
		  Email		  chou@wvision.asia
		  Internet	 www.onecnc.com.tw

United Kingdom
				   OneCNC UK

		  Phone 		  +44 (0) 190 237 3054 
		  Fax 		  +44 (0) 190 237 5593
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk

USA
				   OneCNC LLC

		  Toll Free	 +1 877 626 1262
		  Phone		  +1 813 874 2335
		  Fax		  +1 813 874 2919
		  Email		  support@onecnc.com
		  Internet 	 www.onecnc.com 

USA California
				   OneCNC West

		  Phone		  +1 909 931 7811
		  Fax		  +1 909 985 6967
		  Email		  support@onecncwest.com
		  Internet 	 www.onecncwest.com 
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Copyright Notice

Copyright © 2020     All Rights Reserved 

This publication or parts thereof, may not be reproduced in any form, 
by any method, for any purpose.

Trademarks

The following are registered trademarks of QARM Pty Ltd, in Australia 
and/or other countries: OneCNC XR8, OneCNC XR7, OneCNC XR6, 
OneCNC XR5, OneCNC XR4, OneCNC XR3, OneCNC XR2, OneCNC XR, 
OneCNC XP, OneCNC 2003, OneCNC 2000, OneCNC, AusWire, AusMill, 
AusCAD, AusCADCAM, NCSentry, NCLink.

Third-Party Trademarks

All other brand names, product names or trademarks belong to their 
respective holders.

QARM Pty Ltd. MAKES NO WARRANTY, EITHER EXPRESSED 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, REGARDING THESE MATERIALS AND MAKES SUCH 
MATERIALS AVAILABLE SOLELY ON AN “AS-IS” BASIS. IN NO 
EVENT SHALL QARM Pty Ltd BE LIABLE TO ANYONE FOR SPECIAL, 
COLLATERAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF 
THESE MATERIALS. THE SOLE AND EXCLUSIVE LIABILITY QARM Pty 
Ltd., REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED 
THE PURCHASE PRICE OF THE MATERIALS DESCRIBED HEREIN.

QARM Pty Ltd reserves the right to revise and improve its products as 
it sees fit. This publication describes the state of this product at the 
time of its publication, and may not reflect the product at all times in 
the future.

Copyright Notice
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